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Exercise:
A. 1.
B. 1.

Class -7

Chapter-1
(a) 2. (b) 3. () 4. (b)
Monitor:

A visual display unit as it is called, is an electrical equipment that display
images generated by the video output of a computer.
Ex- CRT & LCD screens.

2. Keyboard:
Keyboard is similar to a typewriter. The keys or buttons act as electronic
switches or mechanical levers with characters printed on them.
3. Hard Disk:
It is a magnetic disk on which you can store computer data. The term hard
is used to distinguish it from a soft, or floppy. Hard disk hold more data and
are faster than floppy disks.
Yes/No
1. Yes 2. Yes 3. Yes 4. No
5. No
1. CRT-Cathode RayTube
2. CD-ROM-Compact Disk- Read only memory
3. RAM-Random Access Memory
4. POST-Poweronself Test
5. LCD-Liquid Crystal Display
6. RGB-RedGreen & Blue
1. Operating System 2.  Post 3.  Pits,Lands
4. Monitor 5.  LinePrinter
1. When we start our computer, there is an operation which is performed
automatically by the computer whichis also called as booting.
2. Post stands for power on self test, This process checks the basic system
functions before attempting to load an operating system.
> Impact Printers Non-Impact Printers
a) It produce the output by |a) Itgeneretesa characters by
processing a print element and shooting small droplets of ink
an inked ribbon against the face onto the paper.
of continous paper form.
b) Itisoftwotypes: b) Itis of two types:
—>Line Printers —>Inkjet printers
—>Character Printers —>Laser Printers
4. The full name of CD-Rom is compact Disk-Read only memory. It is a read only

information storage device. A CD-Rom consists of there layers. It has a
transparent substrate as its base. Once base there is a reflective metal layer
which carriesinformation. On top of it, there is a protective coating.
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Activity

A. Do ityourself.
B. Do it yourself.
C. Doityourself.

Chapter-2
Exercise:
A. 1. (b) 2. (o) 3. (a)&(b)
B. Assembly Language Machine Language
a) ltisalow-level programming a) Itisthe basic low level

language for microprocessors
and other programmble devices. | b)
b) The code is in the form of

programming launguage.
The code isin the form 0 & 1
Ex- 0110100

mnemonics
Ex-ADD
C. 1. High-level language 2. Programs
3. Java 4.  Machine language

D. 1. Variousforms of operating system are:

a) CUI- Ex- Dos b)
2. Language translator is a program which is used to translate instruction that
are written in the source code to object code i.e. from high level language or

GUI- Windows

assembly language into machine language.

3. A compiler is a language translator that translates high-level languages
programs to machine language programs to machine language programs.
While translating, it checks the syntax (grammar of the source code) and

translatesitinto object code at a single attempt.

4. The word ‘App’ is the abbreviation for application. It is software which can
men on a phone, a computer, the internet, or any other electronic devices

having processing capabilities.

Types of Apps:
There arethree types:
a) Nativeapps Ex-Jav, ios-objective
b) Webapps Ex-HTML5 & javascript
c¢) hybridapps PDFfiles
Activity
Do it yourself.
Chapter-3
Exercise:
A. 1. (a) 2. (c) 3. (b) 4. (c)
5. (c)
B. YesorNo:
1. No 2. Yes 3. Yes 4. No
5. Yes 6. Yes




C. 1.
5.
D.
E.
F. 1.
2.
3.
4.
5.
Activity
A.
B.
Exercise:
A. 1.
B. 1.
4,
C. 1.
D. 1.
5.
E. 1.

xls 2. multiple 3. plus 4. value
100

Benefits of multiple worksheet:

The ability to have multiple worksheets in an Excel workbook allows you to
organise your data. Each worksheet can contain a different st of data.

Autofill

Whether you just want to copy the same value down or need to get a series of
numbers or text values, fillhandle in Excelis the feature to help.

Spreadsheet:

These are the documents in which data is laid out in rows and columns like a
big table. It is used to store data related to business inventories, income and
expenses, debits and credits.

The main advantages of using an electronic worksheet are that it uses
electronic spreadsheet in place of antiquated paper-based worksheets. We
canchangethevalue storedin aspreadsheet cell.

Different types of data available in Excel are-

(a) Text (b) Values

(c) DateandTimes (d) Formulas

Wrapping of Text:

Excel can wrap text so it appears on multiple lines in a cell. You can format the
cell so the text wraps automatically or enter amanual line break.
Selectingacell:

If wantto selectacell just onceclickonit.

Selectingarange of cells:

If you want to select a range of cells then you have to click on a cell and then
while clicking on the mouse, drag the mouse diagnolly. Then range of cells get
selected.

Do it yourself.

Do it yourself.

Chapter-4
(.a) 2. (c) 3. (o) 4. (.a)
Photo album 2. View 3. Slide show
Timing 5. Preview
No 2. Yes 3. No 4. Yes
(d) 2. (o) 3. (e) 4. (b)

(a)

PowerPoint allows you to import a set of pictures into a photo album
presentation. With this feature you can select, rearrange, adjust and add
text to your pictures.
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Activity

2.

There are 5 views available in PowerPoint 2016.

They are:
(a) Normal view (b) Outline View
(c) Slide sorter view (d) Notes pane view

(e) Reading view

Action buttons are built in button shapes that you can add to a
presentation and set to link to another slide, play a sound, or perform some
other actions.

(a) Select the object and click on the Animations tab.
(b) Click the more arrow button. Select the option.
(c) Select the desired effect.

It is the animation that occurs when you advance from slide to slide within
the presentation.

A. Do ityourself.

B.
Exercise:
A. 1.
B. 1.
2.
3.
4,
C. 1.
2.
3.

Do it yourself.

Chapter-5

(c) 2. (.a) 3. (o) 4. (.a)
Status Bar-

Itdisplays information about the current object or view

Record Selector-

Itdisplays the current record number and navigates to other records.
Objectstabs:

It provides access to all the open database objects like tables, reports and
forms.

Navigation Pane:
It shows all the available database objects.

Ms-Access is a Relational Database Management system (RDBMS) developed
by Microsoft. It provides a quick and easy way to develop databases and is
particularly well suited for individuals and small business.

(a) OpenAccess 2016 fromthe start menu.
(b) ClickonBlank database
(c) Enterthefile nameinthe File name box
(d) Click oncreate button.
Ablank desktop database will appear
(a) Openthedatabaseinthe datasheetview
(b) Click onthe down arrow of the first field. A drop-down list of options will

appear.
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Activity

(c) Clickonthetype of datayouwantto enterinthefield.
(d) Now, enteraname forthe field

(e) Repeatsteps(b)to(d)

(f) Now, entertherequired datainall thefields

Primary key is a standard feature of every database management system. It is
asortofcheckonthetable thatevery recordinthe tableis unique.

Setting a Primary Key:

(@) InDesignview, clickonthe field that we want to set as the Primary key.
(b) Now, Click onthe Primary key button, Present on the Design tab.

(c) Thefield will be setasthe Primary key.

A Database is a collection of data organised in a manner that allows easy
access, retreval and use of that data.

A. Do ityourself.

B.
Exercise:
A. 1.
B. 1.
5.
C.
(1)
(2)
(3)
(4)
D. 1.
2.
E.

Do it yourself.

Chapter-6
(c) 2. (c) 3. (a)
YES 2. NO 3. YES 4, YES

NO

Steps to save a New object:

Select the object you want to save

Select the File tab in the Backstage view

Click save as

Name its and click on ok in the ‘Save As’ dialog box.

Displaying and Sorting objects:

We can select the way in which the objectsin the database are displayed in the
Navigation Pane.

For ex- We can include the creation or modified dates, or display objects as
icons or lists.

Saving a new object:

Itis a good idea to save our work as we go along saving our work often is the
best way to ensure that we don’t lose any information if our computer
crashes.

Stepstorenameanobject:

(1)
()
3)

Ifthe object we want to renameis open, close it.
Inthe Navigation Pane, right- click the object we want to rename.
Select Rename

(4) Typethenew name.Then, press enter key
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Activity
Doityourself.

Chapter-7
Exercise:
A. 1. (o 2. (o) 3. (c) 4. (a)
B. 1. (d) 2. (a) 3. (b) 4. (c)
C. 1. Yes 2. No 3. Yes 4. Yes
5. Yes
D. 1. Command 2. Container 3.  pairs 4. tags
E. Webpage Website
(1) It is a smaller part of a larger | (1) Itis collection of web pages with
website usually containing more information on a subject.
specificinformation. (2) It would be a book.

(2) Ifitisachapterofbook.

F. 1. HTML,HTML+,HTML2.0,HTML3.2, HTML4.01
2. HTML is a language which is easy learn and understand for designing
websites.
Features:
(a) Itisnota casesensitive language.
(b) Itissupported onalmosteverybrowser.
(c) Notranslator programisrequired.
3. Requirementsfor creating a webpage:
(a) TextEditor
(b) Awebbrowser
(c) Awebserver
4. Structure of HTML documents consists of at least four tags (commands):-
(a) HTMLtag- Itisacontainertag.
<HTML> ------mmmm e </HTML>
(b) Headtag-
<HEAD>-------=--=-=---- </HEAD>
(c) Titletag-
Syntax:
<HEAD>
<TITLE>-----mmmmmmmmmev </TITLE>
(d) Body Tag-

5. HTML stands for Hypertext Markup language. It is easy to learn and
understand for designing websites. It was develop by Tim-Berners-Lee in

1980.
6. .HTML.or .HTM.
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Activity
A. Doityourself.
B. Doityourself.

Chapter-8
Exercise
A. 1. (b) 2. (.a) 3. (.b) 4. (b)
B. 1. Eraser,Blue&Smudge 2. GradientTool
3. ColorReplacementToll 4. Pre-defined
5. Patternstamp
C. 1. (e) 2 (a) 3. (b) 4. (c)
5. (d)
D. 1 Clone Stamp Tool Pattern Stamp Tool
(a) It is used to sample pixels|(a) Itis usedin making design.
from one part of theimage to We can use it to give
pointinanother. interesting textures &
background to your image.
2. StepstoapplyFilters:
(a) Opentheimage
(b) Click on Filter menu and point to the desired category of filter, (eg.
Artistic)
(c) FromArtisticsub-menu, select desired option.
(d) Dialogboxappears, fromtheirselect desired option and click ok.
3. Stepsforaddingtexttoanimage:
(a) Openanimage & select Typetool.
(b) Gotooptionbar&selectfont, colour, size etc.
(c) Clickonimage & starttyping the text.
By default, the Horizontal Type tool is active
4. Magic Eraser Tool automatically clears continously coloured areas. It is useful
inremoving the background from animage.
5. The smudge tool blends the pixels like the action of dragging a finger through
wet point.
6. Theoptionsavailablein Transform menu:
(a) Scale:

When you position the mouse pointer over a sizing handle, the pointer
becomes double arrow.

(b) Rotate:

When you place the mouse pointer over a corner handle it takes the shape of
acurved, two-sided arrow.

(c) Skew:
Dragaside handle to stretch the image.
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(d) Distort:
Draga corner handle to distort the image
(e) Perspective
Dragacorner handleto apply a perspective to the image
(f) Flip horizontally & vertically
Activity
A. Do ityourself.
B. Dot yourself.
C. Do ityourself.

Chapter-9
Exercise
A. 1. (o 2. (c) 3. (.a) 4. (a)
5. (a)
B. 1. COBOL 2. C++ 3. PASCAL 4. FORTRAN
5. Patternstamp
C. 1. CLS:
This command is used to clear the output screen whenever you run the
program.
2. GOTO:

This command is used to tell the computer to go to another place in the
program and ram the same program member of time unconditionally

3. PRINT:
This command points the statement or data written after it.
4. End:

This command is used to finish a program. After reaching the End command,
the computer stops reading lines and points this message.

D. 1. ProfessorJohnGeorge Kemeny & ThomasE. Kurt

2. Qbasicisveryeasyandsimplelanguage to understand.
Qbasic stands for Quick Beginners All purpose symbolic Instruction code.

3. (a) ltisauserfriendlylanguage.
(b) Itis one of the most flexible language.
(c) Languageiseasy asthevariablescan be named easily

4. The various components of Qbasic window are menu bar, status bar, sub
menu bar, program title, program mode & immediate mode.

5. INPUT LET

(a) Itis used to take inputs data | (a) This commands is used to
fromthe user. give a numeric or string
constant to variables.
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6. Constants Variables

(a) Aqtyinacomputer program | (a) It is the storage area whose
which does not change its contents can vary during the
value during the execution of processing of the program.
the program. (b) Its types are:

(b) It'stypesare: —Numerical Variable
—Numeric constant —Alphanumeric or string
—Alphanumeric or string variables.

constant.
Chapter-10
Exercise
A. 1. (b) 2. (a) 3. (b) 4. (b)
B. 1. No 2. No 3. No 4. No
5. Yes
C. 1. InternetStands for International Network. It is the wider network that allows

Activity

computer networks around the world run by comparies, governments,
universities and other organisations to talk to one another.

The first part of the URL is called a protocol identifier and it indicates what
protocol to use and the second part is called a resource name & its specifies
the IP address other domain name where the resourced is located.

Stepsto searchthe web:

(a) Click the address bar and type the search term. As we are typing,
microsoft Edge will display suggestions.

(b) Clickone of the suggestions to navigate to a website or see reults.

Microsoft Edge uses four buttons for navigation: the back, forward, refresh
and home buttons.

Netiquette means Internet Etiquette. It a set of rules for online behaviour.
(@) Nevertypeyourletter or mailin capital letters.
(b) Itmaynotbe pleasantto use sarcasminyour e-mail.

(c) Do not open and attachment in an e-mail if the attachment name is
suspicious.

A. Doityourself.

B. Doityourself.
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